NN

Stellar Converter
for MBOX - Technician 4.0

User Guide



Overview

Stellar Converter for MBOX - Technician converts mailbox from Thunderbird, Spicebird, Entourage,
Pocomail, Eudora, AppleMail, Mulberry, SeaMonkey, Netscape, ClawsMail, OperaMail, MozillaMail,
Evolution, Sylpheed, Cone, Mutt, and Gnu Mail files to Outlook mailbox (PST files). You can see the

preview of converted mails after successful completion of conversion process.

The software gives option to save the converted mails to a new or existing Outlook PST file.

Key Features of Stellar Converter for MBOX - Technician

e New and enhanced GUI.

o Option to apply Filter.

e User friendly and secure software.

e Converts Thunderbird files to Outlook PST files.
e Converts Cone to Outlook PST files.

e Converts Mutt files to Outlook PST files.

e Converts Gnu Malil files to Outlook PST files.

e Converts Spicebird files to Outlook PST files.

o Converts Entourage files to Outlook PST files.
e Converts Pocomail files to Outlook PST files.

e Converts Eudora files to Outlook PST files.

e Converts AppleMail files to Outlook PST files.

e Converts Mulberry files to Outlook PST files.

e Converts SeaMonkey files to Outlook PST files.
e Converts Netscape files to Outlook PST files.

e Converts ClawsMail files to Outlook PST files.
e Converts OperaMail files to Outlook PST files.
e Converts MozillaMail files to Outlook PST files.
e Converts Evolution files to Outlook PST files.

o Converts Sylpheed files to Outlook PST files.



Option to save the converted file in Office 365, EML, MSG, RTF, PDF and HTML formats.
Supports MS Outlook 2016.

Provides preview of mails.

User can open attachments with the preview.

Log Report.



Installation Procedure

Before installing the software, check that your system meets the minimum system requirements:
Minimum System Requirements

e Processor: Pentium Class (1 GHz or faster)

e Operating System: Windows 10 / Windows 8.1 / Windows 8 / Windows 7

e Microsoft Office: 2016, 2013, 2010, 2007, 2003

¢ Memory: Minimum 2 GB (Recommended 4 GB)

o Hard Disk: 250 MB of Free Space

To install the software, follow these steps:

e Double-click StellarConverterforMBOX-Technician.exe executable file to start installation.

Setup - Stellar Converter for MBOX - Technician dialog box is displayed.
o Click Next. License Agreement dialog box is displayed.

e Choose | accept the agreement option. Next button will be enabled. Click Next. Select

Destination Location dialog box is displayed.

o Click Browse to select the destination path where the setup files will be stored. Click Next.

Select Start Menu Folder dialog box is displayed.

o Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks

dialog box is displayed.
e Choose the check boxes as per your choice. Click Next. Ready to Install dialog box is displayed.

¢ Review the entries. Click Back if you want to change them. Click Install to start installation. The

Installing window shows the installation process.

o After completing the process, Completing the Stellar Converter for MBOX - Technician Setup
Wizard window is displayed. Click Finish.

Note: Clear Launch Stellar Converter for MBOX - Technician check box before clicking Finish to

prevent the software from launching.



Launching the Software

To launch Stellar Converter for MBOX - Technician in Windows 10:

e Click Starticon -> All apps -> Stellar Converter for MBOX - Technician -> Stellar Converter
for MBOX - Technician Or,

e Double click Stellar Converter for MBOX - Technician icon on the desktop. Or,
o Click Stellar Converter for MBOX - Technician tile on the home screen.
To launch Stellar Converter for MBOX - Technician in Windows 8.1/ 8:
o Click Stellar Converter for MBOX - Technician tile on the home screen. Or,
¢ Double click Stellar Converter for MBOX - Technician icon on the desktop.

To launch Stellar Converter for MBOX - Technician in Windows 7:

e Click Start -> Programs -> Stellar Converter for MBOX - Technician -> Stellar Converter for
MBOX - Technician. Or,

e Double click Stellar Converter for MBOX - Technician icon on the desktop. Or,

e Click Stellar Converter for MBOX - Technician icon in Quick Launch.



User Interface

Stellar Converter for MBOX - Technician software has a very easy to use Graphical User Interface. The

user interface contains features required for conversion.

After launching the program, you will see the main user interface as shown below:

The user interface contains menus and buttons that lets you access various features of the software with

ease.
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Click this button to open Select MBOX dialog box.

Click this button to access the Saving Options.

Click this button to exit the application.

Click this button to switch between horizontal and vertical views of the reading
pane. When you click on a folder in left-pane, by default, the right pane shows
the details in vertical columns position. You can click Switch Reading Pane icon

to change the position to horizontal columns.

Click this button to view the log report, which contains the details of the

scanning process.

Click this button to check for both, latest minor and major version available

online.

Click this button to activate the software.

Click this button to access the User Guide.
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Ordering the Software

Click https://www.stellarinfo.com/email-tools/mbox-to-pst-converter.php to know more about Stellar
Converter for MBOX - Technician.

To purchase the software online, please visit https://www.stellarinfo.com/email-tools/mbox-to-pst-

converter/buy-now.php

Alternatively, click Buy Online button from the Buy Now menu to purchase the software online.
Select either of the methods given above to purchase the software.
Once the order is confirmed, an activation key will be sent to you through e-mail, which would be required

to activate the software.


https://www.stellarinfo.com/email-tools/mbox-to-pst-converter.php
https://www.stellarinfo.com/email-tools/mbox-to-pst-converter/buy-now.php
https://www.stellarinfo.com/email-tools/mbox-to-pst-converter/buy-now.php

Activating the Software

The demo version is for evaluation purpose only. You need to activate the software to use its full

functionality. Use the Activation Key received via email after purchasing the software to activate it.
To activate the software
1. Run demo version of Stellar Converter for MBOX - Technician software.

2. Click the Activation button. Activation dialog is displayed as shown below:

Activation

Erter activation kay to activate the product

Activate

The activation ey will be in your Emad. Cancel

| dont hawe an Activation Key

3. If you don’t have the activation key, click Get it now button in the dialog to purchase the software.

4. Once the order is confirmed, an Activation Key will be sent to the email that you have provided

while purchasing the software.

5. Paste or type the Activation Key (received through email after purchasing the product) and click

Activate button (Please ensure an active Internet connection).

Activation

Erter activation kay to activate the product

K00E-X00-R000 000 000 Activate

The activation ey will be in your Emad. Cancel

| dont hawe an Activation Key

3. Stellar Converter for MBOX - Technician automatically communicates with the license server to

verify the entered key. If the entered key is valid, activation is completed successfully.



4. ’Activation Complete’ message is displayed. Click OK.

o N Activation Complete.

OK




Updating the Software

There are periodical software updates for Stellar Converter for MBOX - Technician. Using the update

option, you can check for both latest minor and major version available online. You can easily download

the minor and major version through the update wizard. While updating the software, it's recommended to

close all the running programs.
To start Stellar Converter for MBOX - Technician Update Wizard:

1.

Run Stellar Converter for MBOX - Technician software.
Select Update Wizard from Tools Menu.
Update window pops up.

The wizard will start searching for the latest updates and if it finds any new version, a window will

pop up indicating the availability an update.

Click Next and the software will start downloading update files from the server. When the process

is complete, the software will update to the latest version.

Live Update may not happen due to following reasons:

Internet connection failure
Unable to download configuration files
Unable to locate updated files or version

Unable to locate executable file



Stellar Support

Our Technical Support professionals will give solutions for all your queries related to Stellar products.

You can either call us or go online to our support section at http://www.stellarinfo.com/support/

For price details and to place the order, click https://www.stellarinfo.com/email-tools/mbox-to-pst-

converter/buy-now.php

Chat Live with an Online technician at http://www.stellarinfo.com

Search in our extensive Knowledge Base at

https://www.stellarinfo.com/support/kb/index.php/category/mbox-to-pst

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php

E-mail to Stellar Support at support@stellarinfo.com



http://www.stellarinfo.com/support/
https://www.stellarinfo.com/email-tools/mbox-to-pst-converter/buy-now.php
https://www.stellarinfo.com/email-tools/mbox-to-pst-converter/buy-now.php
http://www.stellarinfo.com/
https://www.stellarinfo.com/support/kb/index.php/category/mbox-to-pst
http://www.stellarinfo.com/support/enquiry.php
mailto:support@stellarinfo.com.

Select File(s)/Identity

To select MBOX file / Identity:

e Launch Stellar Converter for MBOX - Technician. Select MBOX dialog box is displayed as
shown below:
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¢ From the Email Client drop-down list, select the Mail Client you want to convert.
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o Click Select File/Select Identity button and locate file/ldentity.
e The path of the selected file/identity is displayed in the File path text box. All of the selected files
along with their path and size are displayed in the form of a list.

e Select the desired file(s) to be converted by selecting the checkbox in front of them.

Select email client and mailbox to comvert

Email Cient | & Thunderbird :

Fie Path C:YJsers\Administrator, TS-D 10\DesktopThunderbird\pr Select File

41 | File Path File Size Select identity

| C\Users'\Adminigtrator TS-D10°De... 33 48(ME)
Firvd File

e Click Convert button to start the conversion process.
You can search for a MBOX file using Find File Option in Select MBOX dialog box.

Note: You can only select a complete Identity folder for the following mail clients: Apple Mail, ClawsMail,
MozillaMail, OperaMail, Sylpheed.



Find Files

You can search for Thunderbird, SpiceBird, PocoMail, Eudora, Entourage, Mulberry, SeaMonkey,
Netscape, Evolution, Cone, Mutt, Gnu files using Find File Option in Select MBOX dialog box. You can

search for files in drives, folders and sub folders. However, you can select only one drive at a time to

search for files.
To search for files:
e Click Find File Option in Select MBOX dialog box.

e Browse for Folder dialog box opens.
e Select the required drive/folder/sub folder and click OK to search for files.
e After the search is completed, list of files found in the selected drive/folder/sub folder is shown in

Select MBOX dialog box as shown below:

Select MBOX
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e Select file(s) you wish to convert from this list and then click Convert to start the conversion process.



Preview of Mails

You can see the preview of converted mails after successful completion of conversion process. Left pane
displays selected MBOX filename under Root node in a tree like structure. Middle pane displays the list of
converted mails. To see content of desired mail, click on it in the middle pane. The content is displayed in
the right pane as shown below. You can click Switch Reading Pane icon from the View menu to change

the position to horizontal columns.
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Save Converted Mails

Stellar Converter for MBOX - Technician allows you to save the converted files in various formats like
PST, MSG, EML, HTML, RTF, PDF and Office 365.
To save converted mails into a new PST file:

o Click Save Converted File button on the tool bar or select Save Converted File option in the

Home menu. Select New PST radio button and click Next.

Save As 4
Save Options
* Mew PST Bisting PST MSG RTF
Office 365 FDF EML HTML
MNext

e Adialog box opens. Click Browse and select location for saving PST file and click Save.

Choose Destination

Destination Path:

E:YOutput Data Browse

e A 'Selected items converted and saved successfully' message appears containing a link named

"Open Containing Folder™ which takes the user to the location of saved files or you can click OK

to view the files later.



Conversion Completed

Selected items converted and saved
successfully.

Open Containing Folder

e The converted mails will be saved into a new PST file at the specified location.

To save converted mails to an existing PST file:

¢ Click Save Converted File button on the tool bar or select Save Converted File option in the

Home menu. Select Existing PST radio button and click Next.

Save Options
Mew PST ® Existing PST MSG RTF
Cffice 365 FOF EML HTML

Mext

¢ A dialog box opens. Click Browse and select the existing PST file and click Open.

e Click Save.

e A 'Selected items converted and saved successfully' message appears containing a link named
"Open Containing Folder™ which takes the user to the location of saved files or you can click OK

to view the files later.



Conversion Completed

Selected items converted and saved
successfully.

I Open Containing Folder

To apply filter:
o Click Apply Filter link from the Save dialog box.
o A Save Filter dialog appears. Specify the date range in the From and To fields.
o Select Include option if you want to include the converted files between the specified
date range. All e-mails that are sent and received in the specified months will be stored.
o Select Exclude option if you want to exclude the converted files between the specified

date range. All the e-mails except the ones that are sent and received in the specified

months will be stored.

Date Range

From 01-Awg-2018 - To 14-Jan-2019 - Select T

Include
Exclude Mais From Mailboxes Excude ]

Specify senders to be excluded from all mailboxes
Add to List

Email Address
] abe@sxyz.com

OK

You can also exclude the mails from the specific senders. Enter the email address of the sender whose

mails you don't want to save. Click Add to List button. The mails from the specified senders will not be

saved.



To save converted mails to Office 365 format:

o Click Save Converted File button on the tool bar or select Save Converted File option in the

Home menu. Select Office 365 radio button and click Next.

Save Options
Mew PST Existing PST MSG RTF
» Cffice 365 FOF EML HTML

Mext

o Office 365 Login Details dialog box opens. Login by entering the E-Mail ID and Password and

click Save.

Office 365 Login Details

Enter Login Credentials

Email 1D

Password:

Note:
e You need to have a Microsoft Office 365 user account for exporting data to office 365 format.
e To save mailbox data in office 365 format you need to install office 2016, 2013 or office 2010
with service pack2.
e For Domain systems, you cannot export offline data to office 365.
¢ Online mailbox data cannot be exported to office 365. You can only export your offline mailbox

data to office 365.



To save converted mails to MSG or EML or RTF or PDF or HTML format:

o Click Save Converted File button on the tool bar or select Save Converted File option in the

Home menu. Select either MSG or EML or RTF or PDF or HTML radio button and click Next.

Save As x
Save Oplans
Mew PST Bristing PST * MSG RTF
Orfice 365 FDF EML HTML
MNexdt

e A dialog box opens. Click Browse to go to the location where you want to save the converted
mails and click OK.
e Click Save. A 'Selected items converted and saved successfully' message appears containing a

link named "Open Containing Folder" which takes the user to the location of saved files or you

can click OK to view the files later.

Conversion Completed

Selected tems converted and saved
successfully.

Open Containing Folder




Import PST files in MS Outlook

To import PST file in Microsoft Outlook 2016 / 2013:

Open Microsoft Outlook. From File Menu, select Open & Export.

Select Import / Export option from the right pane.

From Import and Export Wizard window, select Import from another program or file, click
Next.

In Import a File dialog box, select Outlook Data File (.pst), click Next.

Click Browse to locate the PST file that needs to be imported. In the options box, select an
appropriate option. Click Next.

In Import Outlook Data File dialog box, select the folders that should be imported in Microsoft
Outlook. Click Finish.

To import PST files in Microsoft Outlook 2010:

Open Microsoft Outlook. In the File Menu, select Open -> Import.

In the Import and Export Wizard, select Import from another program or file, click Next.
In the Import a File dialog box, select Outlook Data File (.pst), click Next.

Click Browse to locate the PST file that needs to be imported. In the options box, select an
appropriate option. Click Next.

In the Import Outlook Data File dialog box, select the folders that should be imported in
Microsoft Outlook. Click Finish.

To import PST files in Microsoft Outlook 2007 / 2003:

Open Microsoft Outlook. In the File menu, select Import and Export.

In the Import and Export Wizard, select Import from another program or file, click Next.
In the Import a File dialog box, select Personal Folder File (PST), click Next.

Click Browse to locate the PST file that needs to be imported. In the options box, select an
appropriate option. Click Next.

In the Import Personal Folders dialog box, select the folders that should be imported in
Microsoft Outlook. Click Finish.



View & Save Log Report

During and after completion of the conversion process, you can see log details in bottom window of
Stellar Converter for MBOX - Technician. The Log Report window displays beginning of the process,
end of the process, name of the file etc. during running of the process. With Stellar Converter for MBOX

- Technician, you can save Log Report to analyze recovery process at a later stage.

e To view log details, click Log Report in View menu on the menu bar. Log Report window opens

as given below.

Log Report X

Descripbion L2
Stelar Converter for MBOX

Fie selacted: (MBOX File) FlePath D:'\Stellar Converter for MBOX-Technican\Data\Thunderbird Profiles\2ygdex 2f. defa.
Sipe : 21.%MB

Scanning started on; Mon Jan 14, 2019 at 09:04:01

Scanning Completed on:Mon Jan 14, 2019 at 09:04:01

File selected: (MBOX File)  FilePath D:\Stellar Corverter for MBOX-Technician\Data Thunderbird\Profiles\2yodax 2f.defa.
Size : 69,29 M8

Scanning started on: Mon Jan 14, 2019 at 09:04:01

Scanning Complebed oncMon Jan 14, 2019 at 09:04.01

Fia selacted: (MBOX File) FiePath D:\Stellar Converter for MBOX-Technician \DataiThunderbird Profiles | 2yode 2f. dafa.
Sipe : 9.94MB

Scanning started on: Mon Jan 14, 2019 at 09:04:01

Scanning Completed on:Mon Jan 14, 2019 at 09:04:01

Fie selected: (MBOX File) FilePath D:'Stellar Corverter for MBOK-Technician\Data \Thunderbird Profiles \2ypdax 2f. defa. ¥
< »

Save Log | Clear Log Close

e Click Save Log button to save log report. Enter file name and choose destination in Save As

dialog box.

o Click Clear Log button to clear Log Report.

e Click Close button to close Log Report.



FAQs

1.

What does the demo version of the software do?
In demo version of the software, you will be able to see the mail body but cannot open
attachments. To view / save all data and open attachments, you need to purchase and activate the

software.

What is MBOX file format?
The MBOX file is the most common format for storing email messages on a hard drive. All the
messages for each mailbox are stored as a single, long, text file in a string of concatenated e-mail

messages, starting with the From header of the message.

An MBOX is a text file containing an arbitrary number of e-mail messages. Each message consists
of a postmark, followed by an e-mail message formatted according to RFC 822. The file format is
line-oriented. Lines are separated by line feed characters (ASCIl 10). A postmark line consists of
the four characters From, followed by a space character, followed by the message's envelope
sender address, followed by white space, and followed by a time stamp. The sender address is
expected to be an addrspec as defined in appendix D of RFC 822
The date is expected to be formatted according to the syntax represented in the augmented
Backus-Naur formalism used by RFC 822.

Which email clients are supported by Stellar Converter for MBOX - Technician?
Stellar Converter for MBOX - Technician supports Thunderbird, Spicebird, Entourage, Pocomail,
Eudora, AppleMail, Mulberry, SeaMonkey, Netscape, ClawsMail, OperaMail, MozillaMail,
Evolution, Sylpheed, Cone, Mutt and Gnu files.

4. Can |l convert a single mail into PST file?

You can only convert a complete MBOX file.

If the location of MBOX files are not known, can | search for then using Stellar Converter
for MBOX - Technician?
Yes, Find File option of the software lets you search for MBOX files in specified drive of the

computer. To know how to use this option, please refer Find Files topic of help manual.



6. Can | convert multiple MBOX files simultaneously?

Yes.

7. 1want to save converted mails into an existing PST file. How can | do it?
Stellar Converter for MBOX - Technician gives you option to save converted mails into an
existing or new PST file. For full details, please refer Save Converted Mails topic of this help

manual.



Legal Notices
Copyright

Stellar Converter for MBOX - Technician software, accompanied user manual and documentation are
copyright of Stellar Information Technology Private Limited, with all rights reserved. Under the copyright
laws, this user manual cannot be reproduced in any form without the prior written permission of Stellar
Information Technology Private Limited. No Patent Liability is assumed, however, with respect to the use

of the information contained herein.

Copyright © Stellar Information Technology Private Limited. All rights reserved.
Disclaimer

The Information contained in this manual, including but not limited to any product specifications, is subject

to change without notice.

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH
REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY
EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR
ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR
INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES
INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS
OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND
THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED,
BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES,
WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION
WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE

THEREOF.



Trademarks

Stellar Converter for MBOX - Technician® is a registered trademark of Stellar Information Technology
Private Limited.

Windows 2000 Server®, Windows 2003 Server®, Windows 2008 Server®, Windows Vista®, Windows
7®, Windows 8®, Windows 8.1®, Windows 10® are registered trademarks of Microsoft® Corporation Inc.
All Trademarks Acknowledged.

All other brands and product names are trademarks or registered trademarks of their respective

companies.

License Agreement - Stellar Converter for MBOX - Technician

Stellar Converter for MBOX - Technician
Copyright © Stellar Information Technology Private Limited. INDIA

www.stellarinfo.com

All rights reserved.
All product names mentioned herein are the trademarks of their respective owners.

This license applies to the standard-licensed version of Stellar Converter for MBOX - Technician.

Your Agreement to this License

You should carefully read the following terms and conditions before using, installing or distributing this
software, unless you have a different license agreement signed by Stellar Information Technology Private
Limited.

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or
use any copy of Stellar Converter for MBOX - Technician with which this License is included, you may
return the complete package unused without requesting an activation key within 30 days after purchase

for a full refund of your payment.

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of
Stellar Converter for MBOX - Technician. For purposes of this License, if you have a valid single-user
license, you have the right to use a single Licensed Copy of Stellar Converter for MBOX - Technician. If
you or your organization has a valid multi-user license, then you or your organization has the right to use
up to a number of Licensed Copies of Stellar Converter for MBOX - Technician equal to the number of

copies indicated in the documents issued by Stellar when granting the license.

Scope of License


https://www.stellarinfo.com/

Each Licensed Copy of Stellar Converter for MBOX - Technician may either be used by a single person
or used non-simultaneously by multiple people who use the software personally installed on a single
workstation. This is not a concurrent use license.

All rights of any kind in Stellar Converter for MBOX - Technician, which are not expressly granted in this
license, are entirely and exclusively reserved to and by Stellar Information Technology Private Limited.
You shall not rent, lease, modify, translate, reverse engineer, decompile, disassemble or create derivative
works based on Stellar Converter for MBOX - Technician nor permit anyone else to do so. You shall not
make access to Stellar Converter for MBOX - Technician available to others in connection with a service

bureau, application service provider or similar business nor permit anyone else to do so.

Warranty Disclaimers and Liability Limitations

Stellar Converter for MBOX - Technician and all accompanying software, files, data and materials are
distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. You
acknowledge that good data processing procedure dictates that any program including Stellar Converter
for MBOX - Technician must be thoroughly tested with non-critical data before there is any reliance on it
and you hereby assume the entire risk of all use of the copies of Stellar Converter for MBOX - Technician
covered by this License. This disclaimer of warranty constitutes an essential part of this License. In
addition, in no event does Stellar authorize you or anyone else to use Stellar Converter for MBOX -
Technician in applications or systems where its failure to perform can reasonably be expected to result in
a significant physical injury or in loss of life. Any such use is entirely at your own risk and you would not

hold Stellar responsible for any and all claims or losses relating to such unauthorized use.

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special,
incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss
of business profits, business interruption, loss of business information, or any other pecuniary loss)
arising out of the use of or inability to use the software product or the provision of or failure to provide
support services, even if Stellar Information Technology Private Limited has been advised of the
possibility of such damages. In any case, Stellar Information Technology Private Limited’s entire liability

under any provision shall be limited to the amount actually paid by you for the software product.

General

This License is the complete statement of the agreement between the parties on the subject matter and
merges and supersedes all other or prior understandings, purchase orders, agreements and
arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive
jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the
State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries

of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any



violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or

future violation of the same provision or any other provision of this License.

Copyright © Stellar Information Technology Private Limited. All rights reserved.



About Stellar

Stellar Data Recovery is a global leader in providing data recovery, data migration and data erasure
solutions for the past two decades. Stellar Data Recovery is a customer centric, critically acclaimed,
global data recovery, data migration & erasure solutions provider with cost effective solutions available for
large corporates, SMEs & Home Users. Stellar Data Recovery is headquartered in New Delhi, India and

has a strong presence across USA, Europe & Asia.

Product line:

Data Recovery

A widest range of data recovery software that helps you recover your valued data lost after accidental

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >>

File Recovery

The most comprehensive range of file undelete and unerase software for Windows and MS office repair

tools. More Info >>

E-mail Recovery

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook
Express and MS Exchange useful in instances of data loss due to damages and corruption of E-mail.

More Info >>

Data Protection

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure

complete data protection against hard drive crash. More Info >>

Data Sanitization

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives,
System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >>


https://www.stellarinfo.com/disk-recovery.htm
https://www.stellarinfo.com/undelete.htm
https://www.stellarinfo.com/mail-recovery.htm
https://www.stellarinfo.com/prevent-dataloss.htm
https://www.stellarinfo.com/prevent-dataloss.php

Data Erasure

Stellar Data Erasure software under the brand BitRaser help businesses & consumers permanently erase
confidential data beyond the scope of data recovery. You can perform high speed bulk data erasure &

generate erasure certificates for audit trail purpose.

BitRaser supports 24 International data erasure standards. More Info >>

For more information about us, please visit www.stellarinfo.com.



https://www.stellarinfo.com/data-erasure/data-eraser-windows.php
https://www.stellarinfo.com/
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